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Introduction
Thank you for purchasing your Link Plug-In Engine Control Unit (ECU). Link G4 ECUs are an
advanced, fully programmable microprocessor controlled Engine Management System.
The G4 software platform boasts an impressive list of features giving a new level of user
adjustment. This flexibility allows the tuner to have complete control over the engine
management system. G4 software employs high resolution fuel and ignition tables with
configurable load and RPM centres. When coupled with up to six dimensional fuel and ignition
mapping, barometric pressure compensation and intake air temperature correction this gives an
unprecedented level of tuning accuracy. All Link G4 ECUs are in field upgradeable, there is no
need to return the unit for software updates.
All Link G4 Plug-In Engine Management Systems are designed with flexibility and ease of
installation in mind. Link Plug-In systems are deigned to replace the circuit board inside the
factory ECU enclosure. This provides an invisible install that requires minimal modification to
vehicle wiring and ECU mounting.
Link Engine Management Systems are designed with the final result in mind. Not only do they
boast an impressive range of performance features, but are designed with a focus on safety,
reliability and drive-ability. However, the ultimate success of your engine management upgrade is
determined by how well the system is installed and tuned.
Installing and tuning any after market engine management system is not to be taken lightly. G4
ECUs give the tuner the control & flexibility that only top after-market engine management
systems in the world can provide. While every effort has been made to keep G4 ECUs as user
friendly as possible, it should be recognised that added features bring added complexity.
The complete setup of your ECU can be divided into two important tasks:
1. This manual covers the installation of your G4 ECU. While it is not strictly essential that this
work is performed by an automotive electrician, the knowledge and tools available to these
professionals makes it highly recommended. Regardless of who does the installation, it is of
utmost importance that instructions provided in this manual are followed exactly throughout the
installation.
2. Once the G4 ECU has been installed it will need to be tuned using a laptop computer with
PCLink software. Information on the configuration and tuning of the G4 ECU is detailed in the
online help section of PCLink. G4 ECUs are shipped pre-loaded with a base configuration that
should be close enough to get most engines running after a few application specific
adjustments have been made. While hearing the engine running on the new ECU for the first
time is always a satisfying feeling, it is important to realise that the job is not complete. The
amount of tuning performed and the experience of the tuner are the two most important factors
in determining how happy you will be with your engine management system.

1.1

Safety Notice
Your Link Plug-In ECU is designed to enhance the performance of your vehicle. However in all
cases, your vehicle must be operated in a safe manner. Do not tune your vehicle while operating
it on public roads. Obey road rules at all times.
WARNING!
Failure to follow all installation and operating instructions may result in
damage to the Link ECU, personal injury, or harm to property.
(c) 2009 Link ElectroSystems Ltd
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Disclaimer
All care has been taken to ensure the pin outs and interconnections of the ECU to the vehicles
wiring harness are correct. However due to variations between vehicle models it is the installers
responsibility to check wiring connections BEFORE installing the ECU. Link will not be held
responsible for any damage caused by the incorrect installation of this product.

1.3

Support Options
Should any issues arise during installation, the following options exist for technical support:
1. PCLink help, press F1 while running PCLink
2. Contact your nearest Link dealer. A Link dealer list is available on our website.
3. Link website: www.LinkECU.com
4. Technical Support Email: tech@LinkECU.com
5. Online Discussion Board: Available from the Link website.
The majority of questions received by the technical support team are clearly answered in the
manuals. To speed up your technical inquiry please consult the manuals to make sure that your
question has not already been answered.

(c) 2009 Link ElectroSystems Ltd
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Pre-Installation
Before installing theLink G4 ECU into the vehicle some pre-installation checks must be
performed.

2.1

Compatibility Check
It is essential that a compatibility check is performed before installing the ECU into the vehicle.
Failure to do so may void the warranty.

2.1.1

Subaru Impreza WRX V10 Adapter
There are two different Subaru Impreza WRX V10 adapters available. These adapters are
categorised as 2004-2006 2500cc and 2007 2500cc. This maybe slightly misleading as some
2006 vehicles require a 2007 adapter.
It is critical that the correct adapter for the vehicle is installed, failure to install the
correct adapter can result in engine component, engine wiring or ECU damage.
The correct adapter can be verified by studying the wiring loom.
If pins A1, A2 and A3 (see pinout section) contain no wires, then the correct adapter required is
the 2007 2500cc version. If these pins contain wires, then the correct adapter is the 2004-2006
2500cc version.

2.2

Board Switch Settings
Some Link G4 ECUs require switches on the board to be set before installation.

2.2.1

Subaru Impreza WRX V10 ECU
There are jumpers located on the circuit board inside the adapter case. These jumpers configure
changes Subaru made between years.
The jumpers MUST be set before installing the adapter in the vehicle.
When the jumper consists of three pins in a row, correct selection is made by moving the jumper
to the appropriate end of the three pins.

When the jumper consists of four pins in a square, correct selection is made by positioning the
two jumpers in either vertical or horizontal orientation.

(c) 2009 Link ElectroSystems Ltd
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Information regarding the correct jumper position for the vehicle is printed on the PCB.
To access the jumpers, one end plate must be removed from the case and the PCB will slide out.
Ensure the adapter is fully unplugged before removing the end plate.

2.3

Injector Impedance
Injector impedance is important and needs consideration before installing the ECU.

2.3.1

Subaru Impreza WRX V10 Adapter
The Subaru V10 G4 Adapter is capable of being used directly with factory injectors.
The adapter board is also able to be used with low impedance injectors running in peak and hold
mode.
For further information regarding injector impedance and peak and hold injection please consult
the Link G4 Xtreme wiring and installation manual.

2.4

Required Modifications
Modifications may be required on some vehicles to make the Link G4 Plug-In ECU function fully.

2.4.1

Subaru V10
The G4 Xtreme is not compatible with the factory knock sensor (knock will not be detected). To
work around this problem, please install an after market Bosch knock sensor.

2.5

Staged Injection Upgrade
A staged Injection upgrade is available for the Subaru Impreza WRX STI 2500cc Version 10
adapter board.

2.5.1

Subaru Impreza WRX V10
Provision has been made for the system to be setup with fully sequential staged injection. Staged
injection can be used in very high horse power applications (500+). The advantage of staged
injection is excellent fuel mixture control at low load, while having the ability to supply large
amounts under heavy load.
To setup the system to run staged injection, the following requirements need to be satisfied:
The primary injectors are connected to Injection channels 1 - 4
The secondary injectors are connected to Injection channels 5 - 8
By default the adapter board uses injection drives 5 - 7 for controlling auxiliary outputs. These

(c) 2009 Link ElectroSystems Ltd
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three auxiliary functions will need to be sacrificed in order to run sequential staged injection. The
adapter design has considered this and located the least critical auxiliaries on these three drives
(CE Light, Cruise Light and Purge Solenoid).
The recommended method of wiring in these extra four injectors is by purchasing a G4 staged
injection wire-terminal kit from your nearest Link dealer. The staged injection wire-terminal kit can
be installed as follows:
On plug B of the ECU, the four top left most pins are the secondary injector drives (highlighted in
grey). The following diagram is looking into the ECU from the wire side.

The existing wires going into this connector need to be removed and replaced with wires from the
staged injection wire-terminal kit. To do this ensure the ECU is not powered. Unplug the Adapter
loom from the Xtreme Adapter board and the Xtreme ECU. On the under side of plug B there is a
white tab, this needs to be pushed in towards the centre of the plug, this releases the locking
mechanism holding the existing wires and terminals. Carefully pull out the secondary injection
wires, and replace the four wires with the coloured staged injection wires. Insure these are fully
pushed in. The terminals can be locked again by pressing in the tabs on the top side of the plug.
Note: The wires removed must be insulated with tape or heat shrink to stop the lights
and/or purge solenoid from activating if the terminal makes contact with ground.
An alternative method to installing the staged injection wire-terminal kit is to cut the loom, once
again ensuring to correctly insulate the cut wires.
Please consult the Link G4 Xtreme Wiring and Installation Manual for detailed on connecting the
secondary injectors.

(c) 2009 Link ElectroSystems Ltd
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Installation
This guide provides information on correctly and safely installing your new Link G4 Plug-In ECU.

3.1

ECU Handling Procedures
WARNING!!!
The following installation process will require handling of both the Link
ECU and factory ECU. Both of these are highly sensitive to electrostatic
discharge and are easily damaged. Follow the anti-static precautions
given in this manual carefully to avoid damaging electronic components.
Warranty claims for ECUs damaged by electrostatic discharge will NOT
be accepted.

ANTI-STATIC HANDLING GUIDELINES

Your body builds up an electrical charge as you move around. This charge can
reach very high voltages. Whenever given the opportunity this energy will attempt to
discharge (usually through your finger tips!). This can be fatal to most electronic
components. Most people have experienced an electrostatic discharge when they
step out of their car or touch a metal bench top.
1. The following guidelines describe precautions that can be taken to reduce the
possibility of damaging your ECU:
2. Work only on a conductive surface. A clean steel bench is suitable.
3. Always wear a wrist strap that is electrically connected to the conductive working
surface.
4. Touch the working surface regularly.
5. Do NOT touch components on the circuit board.
6. Where possible, only handle the ECU by its plastic header.
7. Do NOT carry the ECU around without anti-static packaging.
8. Do NOT touch the bare terminals in the ECU header.
Observing the above procedures will minimise the chance of damaging the ECU.
Note that failure due to static damage often does not appear until well after it was
caused.

(c) 2009 Link ElectroSystems Ltd
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Fitting the ECU
Information is provided to assist in fitting the ECU into the vehicle.

3.2.1

Fitting a Subaru Adapter ECU
The following image shows the recommended installation setup for the Subaru Impreza WRX/STI
Version 10 Adapter and Xtreme ECU.

The ECU is mounted on the back of the glove box using the supplied mounting plate. The ECU
should be located towards the centre of the vehicle, please check the clearance around the ECU
when the glove box is refitted. The connector end of the ECU should sit flush with the bottom of
the glove box plastic compartment. Use the above image as a reference for correct location.
The adapter is mounted in the position of the factory ECU. There are three tabs that hold the
factory ECU in place, one on each side and one on the back. The tab on the back needs to be
bent down flat so the adapter loom can plug into the adapter. The adapter sits between the two
existing tabs and is held down by the factory metal foot plate.

(c) 2009 Link ElectroSystems Ltd
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Additional Sensors
G4 Plug-In ECUs offer various options for the installation of additional sensors and devices. As a
minimum it is recommended that all ECUs are installed with a Manifold Absolute Pressure (MAP)
sensor and Intake Air Temperature (IAT) sensor. These parts can be purchased if required from
your nearest Link dealer.

4.1

MAP Sensor
It is important that the pressure source for a MAP sensor be taken from a stable pressure source
after the throttle body. It is common to 'T' into the fuel pressure regulators pressure signal. Do
NOT share this signal with other devices such as boost gauges or blow off valves.

4.1.1

Subaru Impreza WRX V10
The Link G4 Subaru V10 Adapter supports several options for fitting of a MAP sensor. Any one of
the following options can be used:
1. Factory MAP Sensor – From factory, all models supported by this ECU are fitted with a factory
MAP sensor. The factory MAP sensor is wired to An Volt 1.
2. Factory MAP Sensor Upgrade – The factory MAP sensor can be upgraded by simply replacing
the factory MAP sensor. Contact your nearest Link dealer for upgrade options.
Make sure that the correct An Volt channel has been selected as MAP sensor in PCLink and a
MAP calibration has been performed before attempting to start the vehicle.

4.2

IAT Sensor
It is highly recommended that an IAT sensor be fitted in all applications to provide an input for
correction of fuel and ignition based on the engines air charge temperature.
An IAT sensor should be fitted in the intake system in a location that accurately represents intake
temperature. The most common location is just prior to the throttle body. Installing in the
manifold is not recommended due to heat soak issues. A fast response sensor must be used in
all forced induction applications.

4.2.1

Subaru Impreza WRX V10
The AFM has a factory fitted IAT sensor. Due to its location this sensor is not suitable for tuning.
A suitable IAT sensor can however be wired to the AFM wiring. The AFMs IAT signal is wired to
An Temp 2. Factory AFM wiring information follows:

Note: It is important that the factory IAT sensor is completely disconnected as not to affect the
after market IAT sensor signal.

(c) 2009 Link ElectroSystems Ltd
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4.3

Expansion Connector
The expansion connector is provided to allow easy connection of additional ECU inputs. An
“expansion cable” needs to be purchased from your Link dealer.
Important points when wiring to the expansion connector:
Do not overload the +5V Out pin. Although this is protected against ECU damage the +5V out
signal also provides power for other sensors.
Do not connect the ground pin to chassis ground. This could cause ground loops and introduce
unnecessary interference. Use this pin only to ground external sensors that are isolated from
chassis ground.

4.3.1

Subaru Impreza WRX V10
Wideband Lambda Expansion Connector
The wideband lambda expansion connector is included as an easy way to connect an after
market lambda sensor system. The connector provides +14V, two grounds and a connection to
analogue channel ANVolt11. The benefits of using a wideband lambda input are as follows:
Closed loop fuel control during cruise resulting in greater fuel economy
Quick tune (automatic fuel table tuning) is possible during the tuning process
General purpose limiting configured to monitor the fuel mixtures under boost. If the mixtures
become undesirably lean, then the engine speed will be limited. See PCLink help for more
examples on how this can be applied.
The following expansion connector wiring information is as follows:
Pin

Function

1

AnVolt11

2

+14V from Main Relay

3

Power Ground

4

Signal Ground

(c) 2009 Link ElectroSystems Ltd
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PC Tuning
G4 ECUs require PC/laptop tuning using the PCLink Tuning Software application running on a
Windows based computer. PCLink may be downloaded from www.LinkECU.com. Note that
when new versions of PCLink are released they are posted on the website and may be
downloaded at no cost. Also note that G4 ECUs must be used with the correct version of
PCLink.
IMPORTANT!
The G4 ECU has on board USB.
BEFORE connecting the ECU to your laptop, the USB drivers must be
installed. Failure to install the drivers on your laptop first may result in
windows assigning incorrect drivers. These drivers will not work with the
G4 ECU and are difficult to uninstall.

5.1

Installing USB Drivers
Before connecting the ECU to your laptop or PC, the ECU USB drivers must be installed. These
drivers are installed as part of PCLink Tuning Software installation as described in the following
section. Should internet download not be practical, a copy of the drivers on CD can be obtained
from your nearest Link dealer.

5.2

Installing PCLink Tuning Software
Due to the frequent updates PCLink Tuning Software is no longer shipped with each ECU. You
will be required to download the latest version of PCLink Tuning Software from: www.LinkECU.
com
Should access to an Internet connection be impractical, the latest version of PCLink Tuning
Software can be requested from your nearest Link dealer on CD.
Installing from the web
1. Go to the above website and navigate to the downloads and software updates section.
2. Download the latest version of PCLink. When prompted to run or save the file, select
save. It is recommended to save this file on the desktop.
3. Double click the saved file and follow on screen instructions.
4. When prompted to install USB drivers, select yes. This may take some time.
5. When installed, open PCLink by double clicking on the icon that has been placed on the
desktop.
Installing from a CD
1. Insert the PCLink disk into you computer’s CD ROM drive.
2. Open 'My Computer'
3. Double click your CD ROM drive.
4. Double click the file labelled PCLinkSetup.exe (or similar name).
5. Follow the on screen instructions.
6. When prompted to install USB drivers, select yes. This may take some time.
7. When installed, open PCLink by double clicking on the icon that has been placed on the
desktop.

(c) 2009 Link ElectroSystems Ltd
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Communicating With Your ECU
After PCLink installation, you will be able to connect the G4 ECU to the laptop to perform set-up
and tuning work.
1. Connect the ECU to your laptop using a Link G4 ECU USB Cable. If not supplied with the
ECU, these can be purchased from a Link dealer. No other adapter or cabling is required.
Connect the cable to the connector labelled USB.
2. If this is the first time you have connected a G4 USB ECU to you laptop follow the driver
installation instructions that appear. When prompted if you want to install drivers select
'Continue Anyway'.
3. Start PCLink by double clicking on the PCLink icon on the windows desktop.
4. Switch the key to the ON position. This will provide power to the ECU.
5. In PCLink, under the 'Options' menu, select 'Connection'. The connection options
dialogue will open. Select the correct COM Port number from the drop down list or select
auto for automatic com port detection.
6. PCLink offers both mouse and keyboard control. To establish a connection between the
PC and ECU using the mouse, click the ‘L’ icon located near the top centre of the PCLink
screen. Alternatively, using the keyboard, press and hold the Ctrl, Shift and L keys. The
same process can be used to disconnect. If a successful connection is established,
PCLink will download settings from the ECU, otherwise you will be warned that an error
has occurred.
7. Make sure the connection shows “ONLINE” in the top right corner of PCLink. The logo
should also be spinning in the top right corner.
8. To permanently STORE any changes made to the ECU click on the 'S' icon near the top
centre of the screen or press F4. If this is not done before turning the ECUs power off all
changes made will be lost.

(c) 2009 Link ElectroSystems Ltd
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Pre-Start Configuration
Before starting the vehicle, important pre-start configurations need to be made.

6.1

Firmware Version
It is recommended that the you Link G4 ECU is running the most up to date firmware. Firmware
version information can be obtained by connecting to the ECU with PCLink and selecting 'ECU
Information' under the Help menu.
The latest firmware can be downloaded from our website with PCLink.
It is recommended that this is performed by an experienced Link dealer as new features may
need to be properly configured.
The firmware can be updated by selecting 'Update Firmware' under the 'ECU Controls' menu in
PCLink. Follow the on screen instructions to complete the firmware update process.

6.2

Base Configuration
All G4 Plug-In ECUs are shipped with base configuration settings. Note that these are provided
to reduce initial setup and tuning times. They are NOT recommended tuning values. PCLink
includes base configurations for various models. Download the appropriate base configuration
into your ECU with PCLink by connecting to the ECU (described in the Connecting To PCLink
section of this manual), then selecting 'Open' under the 'File' menu. Select the appropriate .pcl
file and then select 'Open'. Downloading large configuration files can take up to a few minutes.
Be patient and acknowledge any messages PCLink shows.

6.3

MAP Sensor Calibration
At key on and engine not running the Manifold Absolute Pressure (MAP) Sensor should always
match the Barometric Absolute Pressure (BAP) Sensor. As well as providing altitude correction,
the BAP sensor also allows the MAP sensor to be calibrated prior to tuning.
Link G4 ECUs use an on-board barometric sensor that is calibrated prior to dispatch. This
ensures that all PCLink Tuning Software programs (pcl Files) give a consistent state of tune
throughout the ECU range. This allows a PCL file to be transferred between G4 based ECUs
giving an equivalent state of tune providing all factors affecting volumetric efficiency are equal.
Without the ability to calibrate all the available types of MAP Sensors to the BAP Sensor there
would be significant affects on the accuracy of the resulting tune, especially when tuning with
Manifold Gauge Pressure (MGP) as a load index.
To calibrate the MAP sensor:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.
2. Under the Analog Channels menu, select the An Volt channel that has been wired to the MAP
sensor. Select the correct MAP Sensor Type.
3. Under the 'Options' menu, select 'MAP sensor calibration'.
4. Follow the on screen instructions.
5. Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).
6. Compare the MAP and BAP values and ensure they have a similar reading (within 1 kPa).

(c) 2009 Link ElectroSystems Ltd
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7. Perform a 'Store' by clicking on the S button (top centre of screen) or press F4.

6.4

TPS Calibration
The Throttle Position Sensor (TPS) is used by the ECU to calculate various engine management
parameters used by functions such as idle speed control,acceleration enrichment and motor
sport features. It is important that the ECU knows when the throttle is open and closed (or part
way in between). The following procedure calibrates the ECU to match the TPS:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.
2. Under the Analog Channels menu, ensure that An Volt 3 is set to 'TPS (Main)'.
3. Under the 'Options' menu, select 'TPS calibration'.
4. Follow the on screen instructions.
5. Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).
6. Ensure the Throttle Position value reads 0% when the throttle is closed and 100% when fully
open.
7. Perform a 'Store' by clicking on the S button (top centre of screen) or press F4.

6.5

IAT Sensor Selection
This section only applies when an Intake Air Temperature (IAT) sensor has been wired and fitted
to the intake system. It is important that the ECU is calibrated to match the sensor installed in the
engine. This procedure is as simple as selecting the correct sensor type as follows:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.
2. Click on 'Analogue Channel' in the configuration tree.
3. Select the An Temp channel the sensor has been wired to.
4. Ensure that channel (and only that channel) is set to 'Inlet Air Temperature'.
5. Select the correct 'Temp Sensor Type'.
6. Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).
7. Ensure that IAT reads the correct temperature.
8. Perform a 'Store' by clicking on the S button (top centre of screen) or press F4.

6.6

Input and Output Setup
As the Link G4 Plug-In ECUs are designed to run several models there are a few items that must
be set-up to make the ECU specific to your model.
The Pin Functions section of this manual gives a list of the functions of each channel based on
the target vehicle.
It is the tuners responsibility to make sure that the following channels are set-up correctly for the
vehicle model the ECU is fitted to:
All Auxiliary Output Channels
Use the 'Test On' or 'Test PWM' (at 10 Hz) functions to test the wiring of channels.
All Digital Inputs
(c) 2009 Link ElectroSystems Ltd
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Look at the Digital Inputs runtime values (lower section of the PCLink screen) to confirm each
channels operation.
All Analogue Volt and Temperature Inputs
Look at the Analogue Inputs runtime values (lower section of the PCLink screen) to confirm each
channels operation.

6.7

Trigger Calibration
The following instructions assume that all pre-start set-up instructions given in previous sections
have been completed. Only after all pre-start checks have been made should an attempt be
made to crank the engine. The following steps must be performed before an attempt is made to
start the engine to ensure the G4 ECU is calibrated to precisely measure engine position.
1. Connect the ECU to PCLink.
2. Select 'Fuel', then 'Fuel Set-up':
a. Set ‘Injection Mode’ to OFF. This will prevent the engine from trying to start while the triggers
are calibrated.
b. Perform a Store (press F4) to make sure fuelling is not re-enabled if power to the ECU is
lost.
3. Click on ‘Triggers’ then ‘Calibrate Triggers’.
4. Perform the correct trigger calibration procedure specific to your vehicle as described in the
PCLink Tuning Software online help (Press F1).
Note that trigger calibration must be performed again once the engine is running. Due to the
acceleration and deceleration of the crankshaft at low speeds, an inaccurate measurement of
engine timing is usually made. Also it is often harder to see timing marks with a timing light at
slow engine speeds. Trigger calibration should be checked again at between 2000-4000 RPM
where engine speed is stable and a more consistent timing reading can be obtained.

(c) 2009 Link ElectroSystems Ltd
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First Time Startup
After performing all set-up instructions given in previous sections, including trigger calibration, the
engine is now ready to be started. The following procedure should be used for first time start-up.
1. Turn the ignition key OFF then ON. The fuel pump should prime momentarily upon power up.
2. Connect the ECU to PCLink.
3. Click on each of the runtime value tabs (located about two thirds of the way down the screen)
and check that all values are as expected. Where possible operate sensors (e.g. TPS) to
ensure correct readings are displayed. The following values should be checked:
a. TPS – spans from 0 to 100% when throttle is pressed. If not, perform a TPS Calibration.
b. MAP – should read approx 101 kPa (at sea level) with the engine not running. If not, check
the MAP Sensor Type setting and perform a MAP Calibration.
c. ECT – should read current engine temperature.
d. IAT – should read current intake air temperature.
e. Digital Inputs – Operate switches connected to any digital inputs while watching the runtime
value to ensure they operate as expected.
4. Rectify any faults found in Step 3.
5. Click on the ‘Fuel’ heading, then ‘Fuel Set-up’:
a. Locate the ‘Master’ setting. This will need to be adjusted during or just after start-up.
6. Crank the engine until it starts. Some throttle may be required for first time start-up due to
imperfect tuning. If necessary adjust the Master setting to enrich/lean the engine (increase to
enrich).
7. If the engine fails to start after several attempts, do not crank it endlessly. Stop and determine
the problem before continuing.
8. Check the Trigger Error Counter (found under the Triggers runtime values tab). If this value
increases during cranking/running then there is a trigger setup fault. It is not unusual for this
number to count one or two on the first engine revolution.
9. Once the engine starts, adjust the ‘Master’ (under fuel settings) setting to achieve best possible
running.
10.The engine should now be allowed to fully warm up. It may be necessary to readjust ‘Master’
several times to maintain smooth running. Don’t forget to keep an eye on engine temperature.
11.Once the engine is warmed up and running well, perform another trigger calibration (known
“as setting the base timing”).
12.Perform a Store by pressing F4.

7.1

Final Checks
To avoid potential engine damage and wasted time, the adjustments presented in the following
sections must be made before attempting to start the engine.
For further help on any of the settings discussed below, consult the online Help in the PCLink
Tuning Software. Online help can be invoked by pressing F1, or right clicking any item and
selecting ‘What’s this?’.
Pre-set-up Checks
Before attempting to configure the ECU, ensure the following tasks have been completed:
1. Ensure the ECU and all associated components are connected and correctly wired/
installed.
2. Fully charge the vehicle’s battery, as the engine will be required to be cranked during the
set-up procedure.
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3. Check all oil and water levels are correct.
Connecting to PCLink Tuning Software
Use the following procedure to establish a connection between your Link ECU and PCLink
Tuning Software tuning software.
1. Make sure your laptop battery is fully charged or plugged in to mains power.
2. Connect the ECU to your laptop and connect to PCLink Tuning Software as described in
the 'Communicating with your ECU' section of this manual.

7.2

Essential Tuning Adjustments
It is assumed that at this stage all set-up procedures described in previous sections have been
completed and the engine is running. The following steps detail correct set-up procedures for
some of the more critical ECU parameters (note that MAP Sensor Calibration should have
already been completed by now):
Injector Voltage (Dead-time) Correction
There is always a delay between the injector being energised and the injector actually opening.
Likewise, there is a small delay between the injector being de-energised and the injector closing.
The opening time is considerably longer than the closing time, however the overall result is that
less fuel will flow for a given pulse width than would be expected with an 'ideal injector'. To
compensate for this the injector pulse widths are increased to compensate for this 'dead-time'.
The dead-time for a given injector is a function of the battery voltage, differential fuel pressure and
the type of injector driver (saturated or peak and hold). A typical dead-time at 3 Bar differential
fuel pressure and 14 volts is just under 1ms (ms = millisecond = 1 thousandth of a second).
In applications with a linear 1:1 fuel pressure regulator (i.e. not a rising rate regulator), the
differential fuel pressure (difference between manifold pressure and fuel pressure) will be
constant. Therefore the only variable that is changing will be the battery voltage (this changes
with electrical load and sometimes engine speed). Without correction, the changes in dead-time
will cause the engine to run lean when the voltage drops. If the Injector Voltage Correction is
properly set-up then changes in the battery voltage will not affect the air/fuel ratio.
The injector dead-time table allows the dead-time for different battery voltages to be entered. The
values represent the dead-time in milliseconds. These should increase with falling system
voltage.
Injector dead-time for a particular set of injectors can be determined using a flow bench or on a
running engine.
To determine the injector dead-time using a flow bench, the injectors need to be operated at the
intended operating pressure (normally three bar) and at a constant duty cycle as well as a set
voltage. Vary the supply voltage to the injector and measure minimum pulse width at which the
injectors will flow for a particular voltage. This is the required dead-time for that injector at that
tested voltage.
To determine injector dead-time on a running engine, with the engine fully warmed and operating
at stable air/fuel ratios (a very precise AFR meter is required – a narrow band O2 sensor will not
suffice), electrical drain needs to be applied to the system; the preferred method is disconnecting
the alternator main fuse. Battery load testers are also useful here too.
Watching the air fuel ratios change while the battery voltage drops, the dead-time table can be
trimmed to maintain the same stable air/fuel ratio. Injector dead-time can be viewed as a row
graph. A smooth curve needs to be maintained at all times.
NOTE: any change to the fuel pressure or injectors will require a recalibration of the injector deadtimes.
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Master
Master should be set so that the numbers in the middle of the fuel table end up around a value of
50. This is to allow sufficient span of the numbers in the main fuel table.
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Pin Functions
A list of pin functions is provided, this is useful when configuring your ECU through PCLink.

8.1

Subaru Impreza WRX V10
PCB V1.0

Subaru V10 WRX/STi

Auxiliary Outputs
Aux 1

LH AVCS Solenoid

Aux 2

RH AVCS Solenoid

Aux 3

Tachometer

Aux 4

Fuel Pump Control

Aux 5

Purge Solenoid

Aux 6

Cruise Set Light

Aux 7

Tumble Valves Open (LH & RH w ired in series)

Aux 8

Tumble Valves Close

Aux 9

E-Throttle +

Aux 10

E-Throttle -

Aux – Injection Outputs
Aux - Inj 5

Wastegate Solenoid

Aux - Inj 6

Rear Oxy Heater

Aux - Inj 7

A/C Fan

Aux - Inj 8

Engine Fan

Aux – Ignition Outputs
Aux - Ign 6

AC Relay

Aux - Ign 7

CE Light

Aux - Ign 8

E-Throttle Relay

Analog Channels
An Volt 1

MAP

An Volt 2

TPS (Main)

An Volt 3

TPS (Sub)

An Volt 4

Left Tumble Position

An Volt 5

Right Tumble Position

An Volt 6

Pow er Steer Sw itch

An Volt 7

Rear Oxy Signal

An Volt 8

MAF Signal

An Volt 9

FPS (Sub)

An Volt 10

FPS (Main)

An Volt 11

Wideband Lambda Expansion Plug

An Temp 1

ECT

An Temp 2

IAT from MAF

An Temp 3

Fuel Temperature

Digital Inputs
DI 1

Speed

DI 2

Right Cam Position

DI 3

A/C Request
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DI 4

Clutch Sw itch

DI 5

Brake Sw itch

DI 6

Cruise Cancel OR Resume

DI 7

Cruise Set OR Cancel

DI 8

Start Signal

DI 9

Neutral Signal

DI 10

Cruise Main
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Subaru V10 WRX/STi

Auxiliary Outputs
Aux 1

LH AVCS Solenoid

Aux 2

RH AVCS Solenoid

Aux 3

Tachometer

Aux 4

Fuel Pump Control

Aux 5

Wastegate Solenoid

Aux 6

CE Light

Aux 7

Tumble Valves Open (LH & RH w ired in series)

Aux 8

Tumble Valves Close

Aux 9

E-Throttle +

Aux 10

E-Throttle -

Aux – Injection Outputs
Aux - Inj 5

Purge Solenoid

Aux - Inj 6

Cruise Light

Aux - Inj 7

Rear Oxy Heater

Aux - Inj 8

N/C

Aux – Ignition Outputs
Aux - Ign 5

AC Fan

Aux - Ign 6

AC Relay

Aux - Ign 7

Engine Fan

Aux - Ign 8

E-Throttle Relay

Analog Channels
An Volt 1

MAP

An Volt 2

TPS (Main)

An Volt 3

TPS (Sub)

An Volt 4

Left Tumble Position

An Volt 5

Right Tumble Position

An Volt 6

Pow er Steer Sw itch

An Volt 7

Rear Oxy Signal

An Volt 8

MAF Signal

An Volt 9

FPS (Sub)

An Volt 10

FPS (Main)

An Volt 11

Wideband Lambda Expansion Plug

An Temp 1

ECT

An Temp 2

IAT from MAF

An Temp 3

Fuel Temperature

Digital Inputs
DI 1

Speed

DI 2

Right Cam Position

DI 3

A/C Request

DI 4

Clutch Sw itch

DI 5

Brake Sw itch

DI 6

Cruise Cancel OR Resume

DI 7

Cruise Set OR Cancel
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Start Signal

DI 9

Neutral Signal

DI 10

Cruise Main
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Pinouts
Pin information is provided to assist when troubleshooting. All pinouts are looking into the ECU
(wire side).

9.1

Subaru Impreza WRX V10
The following pin diagram is provided as a support reference. Please contact your nearest Link
dealer for specific pin information.
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Known Issues
All plug-in ECUs are fully tested on a range of relevant vehicles, although there are often
variations that have not been tested. For this reason issues can arise. Please contact your
nearest Link dealer when suspecting a compatibility issue.

10.1 Subaru Impreza WRX V10
There are currently no known issues.
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Warranty Statement
Link ElectroSystems Ltd. Warranty Statement
Effective 5pm, April 5th, 1992
All products manufactured or distributed by Link ElectroSystems Ltd. Are subject to the following,
and only the following, LIMITED EXPRESS WARRANTIES, and no others
For a period of one (1) year from and after the date of purchase of a new Link ElectroSystems
Ltd. Product, Link ElectroSystems Ltd. Warranties and guarantees only to the original purchaser /
user that such a product shall be free from defects of materials and workmanship in the
manufacturing process. A product claimed to be defective must be returned to the place of
purchase. Link ElectroSystems Ltd., at its sole option, shall replace the defective product with a
comparable new product or repair the defective product. This expressive warranty shall be
inapplicable to any product not properly installed and properly used by the purchaser – user or to
any product damaged or impaired by external forces. This is to the extent of warranties available
on this product. Link ElectroSystems Ltd. Shall have no liability whatsoever for consequential
damages following from the use of any defective product or by reason of the failure of any
product. Link ElectroSystems Ltd. Specifically disclaims and disavows all other warranties,
express or implied including, without limitation, all warranties of fitness for a particular purpose
(except for those which apply to product or part thereof that is used or bought for use primarily for
personal, family or household purposes), warranties of description, warranties of merchantability,
trade usage or warranties of trade usage.
Link ElectroSystems Ltd. License Agreement
The programme in this system is licensed not sold. Link ElectroSystems Ltd. Grants you a
license for the programme only in the country where you acquired the programme. You obtain no
rights other than those granted under this license. Under this license you may use the
programme on only one machine at a time. If you transfer the programme you must transfer a
copy of this license and all other documentation. Your license is then terminated. You may
terminate your license at any time. Link ElectroSystems Ltd. May terminate your license if you fail
to comply with the terms and conditions of this license. In either event you must destroy your
copy of the programme.
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